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STC's 51st annual conference

May 9-12, 2004 at the Baltimore Convention
Center.

Join the Society for Technical Communication
for the largest gathering of technical
communicators in the world!

For more information, contact the society
office:

703-522-4114 / www.stc.org

Designing the future of technical communication

Copyright 2003 San Diego STC
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Managing Editor
Catherine Robinson
stcsignature@yahoo.com

Assistant Editor
Jennifer Mallory
jmallory100@hotmail.com

Copy Editors
Pamela Fridie
spfridie@nethere.com

Beth Vollbach
bethvollbach@earthlink.net

Graphics Designer
Fabrizio Scippa
fs@fsdsgn.com

Proofreaders
Theresa Freese
taffyfreese@cox.net

Mark Hall
mark@hallmark-consulting.com

Karie Hebert
karebear18@cox.net

Suzanne A. Hosie
suzy@wote.com

Kitt Medrano
kitt.medrano@wote.com
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bnicholls@cox.net
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About the San Diego Signature

 

Reach hundreds
of technical
communicators
for little cost!
Advertising Rates

Signature is the newsletter of the San Diego Chapter of the Society
for Technical Communication, a nonprofit professional organization
dedicated to educating and advancing the careers of technical
communicators. Newsletters are published monthly during the
chapter year (September through June).

STC has more than 25,000 members and 150 chapters nationwide.
For more information about the San Diego Chapter visit our Web site
at www.stc-sd.org or call our hotline at (619) 525-7716. Write to us
at:

STC San Diego
PO Box 501261
San Diego, CA 92150-1261

Article Submission

This newsletter invites writers to submit articles to be considered for
publication. Send your query and request for writer's guidelines to
stcsignature@yahoo.com. Submission deadlines are the 1st of the
month prior to the publication month. Publication is dependent on
space availability.

By submitting an article, you implicitly grant a license to this
newsletter to run the article and for other STC publications to reprint
it without permission. Copyright is held by the writer. In your cover
letter, please let the editor know if this article has run elsewhere,
and if it has been submitted for consideration to other publications.

Unless otherwise noted, copyrights for all newsletter articles belong
to the authors. The design and layout of this newsletter are © San
Diego STC, 2003.

Permission to Republish

Material published in Signature may be republished if Signature and
the author are credited. After publication, send a printed copy to the
editor at the above address. If the publication is electronic, e-mail
the newsletter URL or PDF to stcsignature@yahoo.com.
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Got questions?
Comments? Want to
place an ad? Contact the
editor at
stcsignature@yahoo.com

Publication Overview

Signature is a Web newsletter published by the San Diego Chapter, Society
for Technical Communication (STC). It is issued ten times a year to more
than 300 local technical communication professionals, managers, and
educators. Other STC chapters, special interest groups, and related
organizations also receive e-mail notification when each issue is posted.
Because Signature is on the World Wide Web, readership is potentially
unlimited.

Signature contains information produced by technical communicators for
technical communicators. Advertising in Signature is the most direct way to
reach the growing technical communications market in San Diego and the
surrounding area.

Publication Schedule

Signature is published every month except July and August. Each issue is
posted on the Web within the first three days of the issue month. Closing
date for advertising is the 10th of the prior month.

Advertising Rates

Rates are based on type of ad (banner, rectangle, button, or text link), which
newsletter page it is on (home page, feature article, or other), and where it
is on the page (top, bottom, or side).

The following discounts apply:
Prepayment for five issues: 10 percent discount●   

Prepayment for ten issues: 20 percent discount●   

Horizontal Banner (see samples at top and bottom of this page)
Home page at bottom: $50
(Top not available.)

Feature article at top: $40
Feature article at bottom: $30

All other articles at top: $30
All other articles at bottom: $20

Medium or Vertical Rectangle (click to see samples)
Editor's Desk at right: $50
Presidential Podium at right: $50

Vertical Banner (see sample at right side of this page)
Feature article at right: $40
All other articles at right: $30

Button (see samples at right side of this page)
Home page at bottom: $40
(Space at the top is not available.)

Feature article at right: $30

All other articles at right: $20

Text link (see samples at right side of this page)
Home page at bottom: $30

Feature article at right: $20

Save BIG on books!

XML Revealed at Last!
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All other articles at right: $10

Specifications

File format: gif (non-animated only) or jpeg
Maximum file size: 18K
Horizontal Banner: 468 x 60 pixels
Medium Rectangle: 300 x 250 pixels
Vertical Rectangle: 240 x 400
Vertical Banner: 120 x 240 pixels
Button sizes: 120 x 90 or 125 x 125 pixels
Text link: No more than 2 lines per ad; no more than 21 characters
(including spaces) per line

(Sizes based on Internet Advertising Bureau Standards)

Submission Requirements

Submit advertisement by e-mail to stcsignature@yahoo.com. Include contact
name and phone number.

If the ad is supposed to link to a Web page, provide the complete URL.
(Linked pages open in a new browser window.)

Payment Information

Payment must be received before the publication date.

After receiving e-mail confirmation from the editor, make check payable to:
STC

Mail check to:
SD-STC
P.O. Box 501261
San Diego, CA 92150-1261

Advertising Policy

The publisher reserves the right to request revisions or to reject advertising.
The advertiser and the advertising agency assume liability for all content of
the advertisement published and for any claims arising thereof against the
publisher. The publisher is not liable for delays in the scheduled publication
dates beyond a refund of prepaid advertising space costs.

Liability

The advertiser shall indemnify and protect the publisher from claims or
expenses which may arise from the unauthorized use of any name,
photograph, drawing, or work protected by copyright, registration, or label
printed as a result of material supplied by the advertiser.
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Chapter President, Walter Hanig
wdhanig@alumni.rice.edu
Walter is responsible for a project converting a large suite of internal
and end-user documentation to structured FrameMaker 7 at NCR.

He has served the chapter as Finance Vice-President and
Administrative Council jester for four years before last year's
adventure as chapter president.

VP-Professional Develoment, Michelle Petersen
mpetersen3@cox.net
Michelle is a senior technical writer at Alaris Medical Systems in
Sorrento Mesa.

VP-Employment, Beth Peisic
bethpeisic@san.rr.com
Beth has a varied background in finance, accounting, and technical
communications. She is a Senior Technical Writer at Intuit.

VP-Finance, Lance-Robert
lance.robert@tarari.com
Lance-Robert is a senior technical publications engineer at Tarari,
Inc., in Rancho Bernardo.

VP-Membership, Sue Heim
sue_heim@msn.com
Sue is a technical writing consultant in San Diego. She previously
served in the San Diego Chapter as Vice President-Professional
Development and as JobMail coordinator.

VP-Programs, Michael Cárdenas
mcardenas@multitrans.com
Michael is president of Multilingual Translations, Inc., a localization
company headquartered in San Diego since 1985.

Newsletter Managing Editor, Catherine Robinson
stcsignature@yahoo.com
Catherine is a senior information engineer in the Teradata division at
NCR. She has enjoyed contributing her time and efforts to STC in the
capacity of judge of the technical writers' competition and
proofreader of the monthly newsletter.

Newsletter Assistant Editor, Jennifer Mallory
jmallory100@hotmail.com
After Jennifer graduated with a degree in literature, she waited for
the job offers to flood in. When the surprise and rejection wore off,
she began a lengthy career in marketing and editing. Currently,
Jennifer works as a Health Information Specialist II with the County
of San Diego.

Chapter Web Site Manager, Kelley Wilson Mesterharm
kelleyw@cox.net
Kelley has an instructional and curriculum design background with
experience in Web accessibility and usability.
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STC Mission Statement

Society for Technical
Communication
901 N. Stuart Street
Suite 904
Arlington, Virginia
22203-1822

703.522.4114 (voice)
703.522.2075 (fax)

E-mail: stc@stc.org Web
site: www.stc.org

Our mission statement is: Designing the future of technical
communication

The Society for Technical Communication (STC) is an individual
membership organization dedicated to advancing the arts and
sciences of technical communication. STC is the largest organization
of its type in the world. Its 25,000 members include technical
writers, editors, graphic designers, videographers, multimedia
artists, Web and Intranet page information designers, translators,
and others whose work involves making technical information
available to those who need it.

Society membership provides opportunities for ongoing learning and
professional networking. Through the efforts of a small, full-time
staff and a large network of volunteers, STC promotes the public
welfare by educating its members and industry about issues
concerning technical communication.

Member: $125 per year (plus a one-time $15 enrollment fee)●   

Student Member: $50 per year (enrollment fee not required)●   
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Sponsorship Opportunities
By Michael Cárdenas, VP Programs

Author Bio

Contact Michael

Would you like to promote your company, get your company name
recognition and, at the same time, help the San Diego STC Chapter? Well, we
have an excellent opportunity for you!

Your company can sponsor a monthly meeting. You will have your company
logo and name on the San Diego STC Web site; you will get additional
recognition at the STC meeting; and you will have a minute or two to present
your company's products and services to the meeting attendees.

The cost per presentation is $150. This includes dinner for one attendee, who
must register in advance of the meeting.

Please contact Michael Cárdenas for sponsorship opportunities:
Phone 619.295.2682 or email mcardenas@multitrans.com.
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Join STC
By Sue Heim, VP Membership

 

 

Mission Statement: Creating and supporting a forum for
communities of practice in the profession of technical
communication

The Society for Technical Communication (STC) is an individual membership
organization dedicated to advancing the arts and sciences of technical
communication. STC is the largest organization of its type in the world. Its
25,000 members include technical writers and editors, content developers,
documentation specialists, technical illustrators, instructional designers,
academics, information architects, usability and human factors professionals,
visual designers, Web designers and developers, translators, and others
whose work involves making technical information available to those who
need it.

Society membership provides opportunities for ongoing learning and
professional networking. Through the efforts of a small, full-time staff and a
large network of volunteers, STC promotes the public welfare by educating
its members and industry about issues concerning technical communication.

Member: $140 per year (including a one-time $15 enrollment fee)●   

Student Member: $50 per year (no enrollment fee)●   

Society Goals
The goals of STC include enhancing the professionalism of the members and
the status of the profession; providing information through publications,
reports, and conferences; and reporting new communication technologies,
methods, and applications; among others.

In addition to the publications you will receive, you will have many
opportunities to further your own education by attending dinner
presentations, seminars, and conferences. You can submit your work in our
annual competitions and receive recognition and awards from your peers.
And you will have plenty of opportunity to network�to meet fellow STC
members.

Join After November 1 and Save on Dues
As part of its annual fall membership drive, STC offers a special discount to
new members who join the Society on or after November 1, 2003.

For the regular member rate of $140 ($125 for dues plus a one-time $15
enrollment fee), new members will be credited with dues paid for the
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remainder of 2003 and for calendar year 2004. That's 14 months of Society
membership for the price of 12.

Among the benefits of Society membership are subscriptions to Intercom, the
Society's monthly magazine, published 10 times a year, and to Technical
Communication, the Society's quarterly journal. These periodicals contain
essential articles on the theory and practice of technical communication.

Other membership benefits include discounts on STC's annual conference,
the largest gathering of technical communicators in the world; eligibility for
association group-rate insurance; and access to STC's special interest
groups. For more information on these and other benefits, visit the STC Web
site at www.stc.org.

Please pass this article to a prospective member. To join STC, prospective
members can fill out an electronic form or download a membership
application at www.stc.org. Those who prefer to have a membership
application mailed to them can request one from the STC office at the
following address:

Society for Technical Communication
901 North Stuart Street, Suite 904
Arlington, VA 22203-1822
(703) 522-4114
stc@stc.org

For more information on the San Diego Chapter of STC, visit our Web site at
www.stc-sd.org or contact Sue Heim, vice president of Membership, at
sue_heim@msn.com.
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Documenting GUI Tasks

Problems with the "Structure-Oriented"
Approach

By Susan Self

Engineers who have become technical writers�or writers experienced mainly
in documenting hardware or command line interfaces�may not know how to
proceed when faced with documenting software with a graphical user
interface (GUI). Their instinct is to produce parts lists or command
descriptions. They proceed to dissect every menu in every window and
describe the function of every command in neat little tables. This is the
"structure-oriented" approach.

The weakness of this approach is that it puts a tremendous burden on the
software user to figure out which command or set of commands should be
used to perform a desired task. A user typically has a task in mind and turns
to the documentation to scan a list of tasks to find the one that matches the
pattern in mind. With "structure-oriented" documentation, the user has to
scan through many tables of commands�tables organized not by topic, but
sequentially according to their occurrence in a menu or interface. Finding an
appropriate command for a task this way is tedious, time consuming, and
difficult. The experience is equivalent to going to a restaurant and being
served all the ingredients of a meal, then having to assemble them and cook
the meal oneself.

The structure-oriented approach becomes even more problematic for users
when the software application is very large and configurable and entails
many smaller tasks to achieve the larger goals of using the tool. In my
career, I have twice inherited structure-oriented documents for complex
software applications. One tool was for building GUIs, and the other was for
planning and simulating cellular networks. In both cases, the product
managers were complaining that customers found it hard to figure out how to
use the tool. My job was to convert these documents into task-oriented
descriptions of the tools and to help users find their way through a sequence
of tasks to achieve their goals.

The Task-Oriented Approach

Define GUI tasks. How do you define GUI tasks? I start with the commands
in the menus and generate task titles that begin with gerunds. For example,
for the Load Configuration command in a File menu, I make a heading called
"Loading a Configuration." Then I make higher-level headings under which I
group lower-level tasks that are related. For example, for a Problem List
Viewer, I have the heading "Managing Window Configurations," under which I
have the task sections "Loading a Configuration," "Saving a Configuration,"
"Saving a Configuration under a New Name," and "Deleting a Configuration."
These groupings are rather obvious.
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Sometimes I need to play with a tool for a while to understand the function
of a command and the tasks in which it is used so I can find an appropriate
group for it.

Organize groups of tasks. After I have grouped all the tasks, I organize
the groupings into the approximate sequence in which the user will perform
the tasks. For example, an introductory section might describe starting and
closing down the application and basic configuration tasks to make it fully
usable. Often several sets of basic tasks must follow in sequence to complete
a goal, so I put these together in a large chunk. In other chunks, I group the
less essential or optional tasks, such as customizing the tool display or using
special features.

Create the procedures. I find that it is easy to map structure-oriented
command descriptions into tasks and then shift around the existing blocks of
text into the new organization of the document. After that, I massage the old
text and start creating the procedures for the GUI tasks by experimenting
with the interface myself. If I'm lucky, I may have a functional specification
to help me figure out the commands. A procedure typically has a numbered
list of steps with screen shots of the interface being used to make the steps
easy to follow. It helps to create a typical example for a feature and show
sequential screenshots of what happens with that example.

Create other helpful features. When many tasks involve the same large
window, it is useful to introduce the window and its parts at the beginning of
the higher-level section that groups the tasks.

Sometimes concepts should be defined before introducing tasks based on
those concepts. For example, before using the configuration commands in a
configuration manager, the user needs to understand the difference between
a "planned configuration" and an "active configuration."

For goals requiring many tasks, it is helpful to create roadmaps, flowcharts,
or tutorials to guide the user through the series of tasks or iterations of
tasks. The user needs the big picture as well as the detailed steps so as not
to get lost.

A good index is another useful aid, enabling the user to identify tasks by
topics and to go to them directly rather than through higher-level headings. I
sometimes also index every window and command with a pointer to the page
where the window or command is used in a procedure. I've found that it is
safer to present commands in procedures than in simple command
descriptions because in the procedures I spell out the preconditions and
warnings related to using the command. This way the user is less apt to
perform a destructive action unwittingly in the process of guessing and
experimenting.

Finally, when documenting GUI tasks, we technical writers should let
sympathy for the user guide us in making the software seem easy to use.
Like good hosts, we should try to anticipate every need of the user and
provide for it gracefully at the appropriate time and place. When we are
successful, the documentation becomes transparent, immediately useful but
not calling attention to itself, and the user has a direct and satisfying
experience with the software.
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Your humor columnist was overrun by a herd of developers this
week. The stampede trampled her funny bone and left her without
mirth. However, we expect her to make a full recovery. In the
meantime, please enjoy this article from our archives.

Review, or What Have You Done for Me
Lately?
By Karen Field Carroll

Author Bio

Contact Karen

"I sat evaluating myself.
I decided to lie down."
Peter McWilliams

It's performance review time again�you know, the time when you
rate your performance over the last year, your boss rates your
performance over the last year, you and your boss discuss your
performance over the last year, and then three months later, you get
a raise (which, of course, has nothing to do with your performance
over the last year).

I hate performance reviews. It's not that I get bad reviews, though.
Aside from the odd negative comment about my candor�which, by
the way, isn't going to change�I've yet to receive a bad one. (And
not everyone thinks candor is bad. Honest people like it.) I just don't
like seeing opinions about my work in writing.

That said, I go through the motions. I fill out the forms, thinking
about where I can improve, where I meet general expectations, and
where I excel.

Writing about where I excel�my accomplishments�is the hardest
part for me. I'm not good at self-promotion. (I'm a tech writer, after
all, not Don King.) And part of me thinks, perhaps naively, that it
should be obvious that I'm a hard worker. I meet all my deadlines,
don't I? The development teams I work with like my work, don't
they? I've survived four rounds of layoffs, haven't I? Doesn't that
speak for itself?

Apparently not. I am still expected to list my accomplishments. So
the other day, I began to ponder my worthiness, and I realized this:
given that I am candid, my performance is reflected not in what I do
but in the restraint I've shown over the last year. In other words, I
excel in negative space; it's what I don't do that should make
headlines.

For example:
When a developer told me that her functional spec was
probably "too complicated" for me to understand and that I
would find it "a painful experience" to read, I did not reach
over and slap her, even though I probably could have.

●   

When the marketing folks changed the name of the product
suite I work on from its original name to another and then
back again in the span of four months, I did not threaten to
refer to the product line as Whatever in my documentation,
even though I probably could have.

●   
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When the people who manage our building (known as
Facilities) began leaving citations on our cubes for things like
messiness or displaying irreverent Dilbert cartoons on the
outer wall, I did not rally my coworkers to TP the Facilities
offices, even though I could have.

●   

Yup, I've been pretty busy this year. Not only have I met deadlines,
written special reports, and rescued a dying project when the tech
writer on the project had to leave it, I've also kept my mouth shut a
lot.

And people say I never do anything around here.
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Act Outside Your Comfort Zone
By Catherine Robinson, Managing Editor

If you find value in the
Signature newsletter,
consider contributing
articles. We need feature
articles, advice, technical
workarounds for
problems you have
encountered, and some
plain old helpful tips.

If you want to improve
your writing skills,
contribute articles. You
will have the opportunity
to work with our great
copyeditors who can give
you pointers and help
you improve your skills.

Contact us at:
stcsignature@yahoo.com.

As I work my way through the first year of the Signature newsletter
season in a role other than proofreader, I find myself challenged with
new things that I previously did not have the initiative to tackle. For
example, in the past I would renew my yearly STC membership,
proofread the newsletter and submit my comments, and attend
membership meetings to listen to the presentations. As the
managing editor for the 2003-2004 Signature newsletter publishing
season, I have forced myself to act outside my comfort zone.

My year as managing editor started with many new challenges.
Because I have decided to face these challenges head on, I have
encouraged myself to act outside my comfort zone.

My comfort zone included avoiding networking, doing things solo a
lot of the time, and, frankly, not taking advantage of what my
membership really had to offer�other resources and experts in our
field.

As I found myself having to keep up with the rigorous publishing
schedule and trying to find ways to get good content for the
newsletter, I stepped out of my comfort zone.

I began to network, contact people, hold others accountable to their
commitments, take into consideration the risks involved if I lose
commitments or resources, and learn what I had to do in order to
grow in the role and let the newsletter flourish. It has been a process
in which I have had to recondition myself.

The results after our first few publications of the newsletter have
been astounding. I feel great about meeting all the wonderful
people, including our great copyeditors who help me to understand
more about writing and the wonderful technical experts who have
helped me to solve a lot of the technical problems. I have also
become comfortable when I've been faced with problems because I
have learned about commitment and trust. I now focus on solutions
rather than the looming problems.

The next time you think you are faced with a challenge that is way
over your head, try acting outside your comfort zone. I can assure
you that you will be pleasantly surprised.
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Thanks To Be Given
By Walter Hanig, President

Author Bio

Contact Walter

Administrative Council

Though this will be published after Thanksgiving, I'm writing this before my
favorite holiday. And I've more reasons to be thankful than usual.

Professional Thanks
Colleagues at Ericsson who demonstrated professionalism day in, day
out and from their first day of employment to the last.

●   

Colleagues at NCR who invited me to join them, listen patiently to my
tales of how things got done (or not) at my many previous jobs, and
teach me patiently how things get done (or not) at NCR.

●   

STC volunteers and other members for their support, encouragement,
and patience (hmmm, sounds like a theme).

●   

Personal Thanks
Firefighters who did more than anyone had a right to expect, and will
do it again. Those who evacuated and had homes to return to know
how fortunate they were.

●   

My family, who put up with late dinners and bad humor.●   

Doctors Israel and Epsten, who treated me as a patient and respected
me as a student.

●   

Pam and Sam who discovered two just-born turtles (Terrapene carolina
carolina) today.

●   

My extended "family," with whom I've spent the last 31 years of laugh-
and calorie-filled extended Thanksgiving celebrations.

●   

As this is, after all, an STC newsletter, I think it's important to thank the San
Diego chapter leaders who've preceded us and set a standard of service:

Year(s) President
1955 R.O. Shockney
1956 L.J. Solheid
1957 H.R. Kennedy
1958 C.M. Johnson
1959 G.R. Spitzer
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1960 Sam Lipsett
1961 H.L. Clower

1962-63 Charles M. Hatcher
1963-64 Edward S. Bill
1966-67 Walter Brees
1969-70 Forrest D. Frame
1971-72 Robert J. Pritchard
1972-73 Frank Hunter
1973-74 Virginia H. Wallihan
1975-76 John E. Stevens
1976-77 Morton Stone
1977-79 Phyllis Minick
1979-80 John J. Smaldino
1980-82 Richard Meyers
1982-84 Margaret E. Cathcart
1984-86 Cathy Chaney
1986-88 Rex Casey
1988-90 Linda Oestreich
1990-93 Tom Hoyt
1993-94 Bonni Graham
1994-96 Anita Craig
1996-98 Jim Desmond

1998-2000 Suzy Hosie
2000-2002 Kris Oden
2002-2003 Walter Hanig

These folks have come from different backgrounds: large companies or small
ones�employees, contractors, or business owners�hardware, software,
policies & procedures, or manufacturing. Whatever their background, they've
shared a common commitment to our profession and, more importantly I
think, to our members.
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December Chapter Meeting Preview: The
Next Generation of Single-Source Tools
for Adobe FrameMaker
By Michael Cárdenas, VP Programs

Click here for December 10
meeting details.

If you make a reservation but find
you cannot attend, please cancel
your reservation by sending an
e-mail to Lance-Robert at
treasurer@stc-sd.org. The chapter
has to pay the hotel for all
no-shows, which takes money
away from various programs that
could otherwise benefit the
chapter members.

There is no financial penalty for
cancelling your reservation. If you
used PayPal to pay for your
reservation in advance and need
to cancel, the full amount will be
refunded to your account within
three working days.

FrameMaker users today are being tasked with creating full-featured
and multimedia-rich online information systems from their existing
print-based content. In many cases, they must re-purpose the same
content for use in multiple online systems, each of which must be
customized for a different audience, software edition, or platform. In
the December meeting, you will learn how to achieve this kind of
single-sourcing, without creating multiple projects or relying on
macros.

Our speaker, RJ Jacquez, will unveil the highly-anticipated RoboHelp
for FrameMaker software, and cover the following topics:

Creating and publishing an unlimited number of online outputs
from a single project.

●   

Controlling which FrameMaker chapters and content are
included in each output.

●   

Customizing your online output further, using the same
building blocks you use in FrameMaker.

●   

Including multiple FrameMaker books in a single project.●   

Creating rmultimedia-rich online experiences for your
end-users.

●   

Automating future projects by reusing templates.●   

Creating online Help systems with full context-sensitive
support.

●   

Batch generating multiple outputs with a single click.●   

Biography

RJ Jacquez is the product manager for FrameMaker Technologies at
eHelp Corporation. RJ has twelve years of experience with Adobe
FrameMaker, including eight years as a professional FrameMaker
instructor. He has also lectured about FrameMaker on behalf of
Adobe Systems at that company's "Beyond Word Processing"
seminars. While formerly serving as Vice President of Technology at
Quadralay Corporation, maker of WebWorks Publisher, Jacquez
gained extensive experience in the areas of single-sourcing,
ePublishing, and Help authoring. Most recently, Jacquez has led a
team at eHelp Corporation to develop an entirely new single-sourcing
tool specifically designed for use with FrameMaker. This tool, code
named "Mustang" was showcased at the 2003 FrameUsers
Conference in October.
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November meeting attendance
numbers:

60 attendees
1 cancellation
3 no-shows
18 used PayPal (a new record!)

Walter Hanig, President

 

Michael Cárdenas, VP Programs

 

 

 

November Chapter Meeting Review
By Eric Hurd

San Diego Chapter Meeting - Wednesday, November 12, 2003

Our chapter president, Walter Hanig, opened our monthly meeting at
the Red Lion Hanalei in Mission Valley by inviting the members who
were looking for work to stand and describe their skills and type of
work they are looking for. Then members with job announcements
were asked to stand and describe the positions that were available.

He next asked for a show of hands of first-time attendees and
conducted an informal survey to find out what they hoped to get
from the meeting. Most of the respondents cited meeting fellow
writers, learning about the industry, and increasing their skill set.

Announcements
Walter pointed out our new Adopt-a-Book Table. Those wishing
to take or leave a book are invited do so at our monthly
meetings.

●   

Write on the Edge's Suzy Hosie is featured in this week's
edition of the San Diego Business Journal. You can read the
article at www.wote.com.

●   

Bryna Block from UCSD needs technical writing examples to
use in technical writing classes. If you have examples that do
not have proprietary restrictions, plese contact Bryna at UCSD.

●   

The fires that devastated our region touched many of us. Our
chapter donated $500 to the Red Cross fund for local fire
victims.

●   

Walter thanked Sue Heim and Lance-Robert for making the
new-member dinner one of the best in living memory.

●   

Kelley Wilson and Sue Heim migrated our chapter site to a new
ISP. The Web team is in the process of redesigning the site.

●   

Michael Cárdenas has graciously volunteered office space in his
company for professional development events.

●   

The annual Region 8 conference in Davis, California (July
25-27, 2004) still needs volunteers. Volunteers can attend the
conference, which features many of the same speakers as the
international conference, at a discounted rate. Please contact
Sue Heim if you are interested.

Walter added that the presentations are great, the conference
is cheaper than the international conference, and traveling to
Davis is a lot easier than traveling to Baltimore.

For more information on the Region 8 conference, visit:

●   
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Sharon Burton-Hardin

http://www.stcregion.org/region8.

Walter announced that a salary survey will be coming up in the
near future.

●   

Our newsletter will be featuring a new "gossip" column that will
feature news of a more personal nature including job changes,
life events, and promotions. If you have news you would like to
share or an idea for a column name, please contact Kitt
Medrano at kitt.medrano@wote.com.

●   

On Thursday, March 25, 2004, we will host a special event
featuring Char James-Tanny who will be talking about the
product "AuthorIT," the bleeding edge of object-oriented help
generation. The presentation will cost $10 and will include
appetizers only.

●   

Featured Speaker: Sharon Burton-Hardin on "How to
get Good PDF"

Sharon Burton-Hardin is the president of the Inland Empire Chapter
of STC. Sharon is the owner of Anthrobytes Consulting in Riverside
and assured us that there are, in fact, technical writing jobs there.
Sharon's wit and fast pace came in handy while tackling the bane of
our existence.

After a quick plug for the technical writing certificate program at UCR
where she teaches (visit www.iestc.org for more information),
Sharon began her presentation by asking how many of us know
exactly which version of Acrobat Reader all of our users have, how
many of us can install newer versions of Acrobat on our users'
workstations, and how many of us can control the graphics that go
into our documentation. After only one of us answered yes to all
three questions, Sharon announced that the rest of us would
encounter problems making PDFs.

Specifics

Sharon presented a lot of helpful information and many anecdotes
that illustrated what she has learned while wrestling with the beast.
To access her detailed notes from the presentation, visit
http://www.anthrobytes.com/portfolio.html and click Getting Good
PDF near the bottom.

Following are some of the highlights from her presentation.
Use the correct printer driver settings. You must use the Adobe
Distiller and the Adobe PPD. Do not use any other printer
driver.

●   

Make sure you have enough space on your hard drive and
partition. You should have 2.5 times the size of your largest
Postscript file.

●   

Use Postscript fonts. TrueType is not supported fully in earlier
versions of Acrobat. Also Reader turns TrueType fonts into
graphics, which increase the file size significantly. Since most
worldwide users still use dial-up connections, and most users
have very old versions of Reader, downloading a file takes an
unacceptably long time.

●   
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Use the best graphics. Always use BMP format for screen
captures. GIF format is small in size, but lacks color depth. JPG
discards information during compression. TIF may have issues
with embedded fonts. PNG supports 64 billion colors and
creates small files. For vector-based graphics, stay away from
EPS unless exact color is very important. If you do use EPS,
make sure the fonts are embedded correctly.

●   

Use the right settings. In a nutshell, the standard Distiller
settings give bad results. Make sure you set them to disable
downsampling and compression, set the backwards
compatibility to Acrobat 3, use the highest DPI possible (2400
press), and embed all fonts. Sharon has a document that you
can view at her Web site:
http//www.anthrobytes.com/portfolio.html.

●   

Tips
Optimize for fast Web view.●   

In the Advanced tab save the originals as JPEG as a backup in
case you lose the source files.

●   

In Acrobat 5, you can export all images (if updating a PDF with
limited source files).

●   

Give your job options a name that will stand out from the
others to ensure they are used (e.g., "You MUST use these
options").

●   

In the PDF setup window, use tags to allow for page resize
when viewed on a PDA. This is also helpful when the source
files are lost because page re-sizing preserves the ends of lines
during copy/paste.

●   

Usability studies suggest that users prefer the PDF to open
with the entire page displayed, even if it is not legible. You can
set the default zoom size, or set password protection, by
opening the PDF and selecting File, then Document Properties.

●   

Find out more at www.pdfzone.com and www.planetpdf.com.

November Meeting Wrapup

Michael and Walter thanked Sharon for her great presentation. I was
impressed with the quantity of useful information she was able to fit
into the allotted time.

Our monthly giveaway winners were:
Alana Krider won an authentic STC bag.●   

Diane Streckert won this month's Wally Buck (good for
dinner and a presentation).

●   

Thank you all for coming. See you in December!
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Alana Krider

Diane Streckert
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San Diego Community College District Offers
Free Computer Classes
By Michelle Petersen, VP Professional Development

 Are you interested in an inexpensive way to expand your computer and
technology skill set? The San Diego Community College district offers a wide
variety of free, hands-on classes through their Centers for Education and
Technology (CET) in several areas around the city.

Upcoming Topics--December 2003/January 2004
In the North City (Kearny Mesa) area, upcoming classes include many topics
that may be of interest to technical communicators. The CET offers classes
aimed at various skill levels for most topics:

Microsoft Applications
Access●   

Excel●   

Word●   

PowerPoint●   

Project●   

Multimedia Applications
3D Studio Max●   

Final Cut Pro●   

Fireworks●   

InDesign●   

Photoshop and Photoshop Elements●   

Web Page Design and Development
Dreamweaver●   

Flash●   

HTML●   

Web Page Design (several topics)●   

XML●   

Web Technology
ASP .NET programming●   

C# programming●   

Java programming●   

PHP and MySQL●   

UNIX●   
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VB Macros●   

VB .NET programming●   

For a complete listing of classes and start dates at the Kearny Mesa location,
go to:

http://www.sandiegocet.net/bit/north-cc/f-classes.php

Class Locations

All free North City classes are held at one of the two Kearny Mesa campuses:
8401 Aero Drive, San Diego, CA 92123●   

5636 Ruffin Road (Datel), San Diego, CA 92123●   

Registering for Classes

To sign up for a class, check the schedule on the CET Web site to see if the
class is being held at the Aero Drive or Ruffin Road (Datel) location:

If your class is offered at the Aero Drive location, simply show up and
get in line on the day that the class is scheduled to begin. Space is
offered on a first-come, first-serve basis.

●   

If your class is in great demand, it is advisable to arrive an hour or so
early to get into the class.

●   

If your class is offered at the Datel location, call the CET at
858-627-2545 to sign up in advance. Pre-registration is required for all
Datel classes.

●   

For classes offered in other locations in San Diego, see the CET Web site:

http://www.sandiegocet.net/
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Members Looking for Work

Illustration © 2002
Ann M. Throckmorton

How to submit an ad

Ads are limited to STC members
and should not exceed 125 words.
Send your ad to the editor at
stcsignature@yahoo.com.

To ensure publication, we'll need
your ad by the 5th of the month
prior to publication. Ads received
after the 5th will be inserted if
possible.

You'll need to renew your ad for
each month you want it
published.

 

Richard Garner
rgarner_1998@hotmail.com
(619) 425-5279

I am a recent graduate, (03/03), of the Certificate Program in
Technical and Scientific Writing at San Diego State University. I did
an internship with Consistent Image of San Diego, California, a small
consulting company that produces the manuals for Sprint Wireless
Communications. At Consistent Image I was responsible for
transferring two large documents from Quark Express 5.0 to
Framemaker 6.0 in precise template form. I also assisted the
company with several other print and online documents. My
supervisor's comments about me and my work include the following:
"A skilled writer," "a very good technical writer," "nice to work with,"
and "excellent work habits."

I also did much of the formatting and visual design work on a
volunteer student team that produced a revision of the Substitute
Teacher Handbook for the La Mesa-Spring Valley School District.

Seeking: A permanent or temporary position as a technical writer

Education: Certificate in Technical and Scientific Writing,
San Diego State University; B.A. in history, University of California,
San Diego

Tools: FrameMaker 6.0, Acrobat 5.0, Word, Excel, HTML 4.0

Samples: I have writing samples available in FrameMaker 6.0 and
Word.

Aptitudes: I am a quick learner and am able to grasp the essential
features of things and processes and describe them in a logical and
thorough manner.

Personal interests: I am eager to help companies and
organizations effectively communicate what they are about to their
customers and clients. I would also enjoy helping them make their
products and services more useful and understandable through clear,
consise, well thought-out verbal and visual communications.
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General Meeting and STC FAQs
By Lance-Robert, VP Finance

Contact Lance

Contact Council Members

Q: How is parking at the Red Lion Hanalei handled? Do we need
validation stickers or stamps?
A: No. When you leave the lot after the meeting, just hand your parking stub
back to the attendant. Tell the attendant you're with the STC, and they will
open the gate for you. (Our contract with the hotel waives the parking fee.)
To avoid misplacing your parking stub, I recommend leaving it in your vehicle
when you park. You do not need to bring the parking stub with you to the
meeting.

Q: Why are the meetings not held in the same room every month?
A: The hotel has other events that come up from time to time, and they
sometimes need to move us to a larger or smaller room, depending upon the
number of reservations we or the other events get for that night.

Q: Is there a map of the hotel's conference rooms available online?
A: Yes. Just click here: http://www.hanaleihotel.com/conference.htm.

Q: Why are meetings always held on the second Wednesday of the
month? Why not another day during the week or the month?
A: The hotel conference rooms are booked a year in advance to ensure that
we have confirmed reservations and that we get the best possible rate from
the hotel. We will have to negotiate another contract at the end of the
chapter year in June. If you have strong feelings about holding the meetings
on another night during the week or month or about the meeting location,
please let any council member know at that time, and we will consider your
request. Also, meeting on a regular day allows members to plan for the
meetings. Note that most, if not all, other professional groups use this
scheduling method.

Q: Why are meetings held at the Red Lion Hanalei instead of the
Wyndham?
A: The Wyndham hotel found that it could book larger groups for the same
rooms and increased the rate for those rooms. Rather than raise the member
attendance fees, we did an extensive search around the central areas of
Sorrento Valley, Mira Mesa, and Mission Valley for viable alternatives. The
Red Lion Hanalei was the best that we could find, and it offers us superior
food and service without our having to raise the attendance fees.

Q: How much does the chapter pay the Red Lion Hanalei to hold its
meetings there?
A: The chapter pays the hotel $19 per person plus a small fee for the
projector screen and, if needed, extra coffee. This fee includes the room, the
dinner buffet, the dessert buffet, the podium and microphone, the setup, and
the parking.
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Q: What happens if I make a reservation but don't show up? Do I pay
a penalty?
A: No. The chapter does not charge a cancellation fee. However, if you find
that your plans change and you cannot attend, please notify the treasurer by
sending an e-mail to treasurer@stc-sd.org. If you do not show up for your
reservation but do not cancel, the chapter still has to pay the hotel for your
reservation. This is money that would be better spent serving the chapter
membership through library books, programs, seminars, and the like.

Q: If I pay online by PayPal but end up canceling my reservation, do I
forfeit the money I paid?
A: No. If you need to cancel, the treasurer will refund the full amount to your
account. There is no penalty, but it might take two to three working days for
PayPal to process your refund.

Q: Where can I find more information about using PayPal to pay for
my meeting reservation?
A: You can find a detailed list of PayPal FAQs, written by yours truly, by
clicking here: http://www.stc-sd.org/meetings/paypal_faq.htm.

Q: How do council members get their positions? Are they elected or
appointed?
A: Council members typically volunteer for their positions for the entire
chapter year (September through June). If more than one person wants a
position, we hold an election. Otherwise, the person who volunteers for the
position is appointed to the position if approved by the council.

Q: How do I volunteer to become a council member or to assist an
existing council member?
A: If you would like to volunteer, please contact any council member, or
e-mail Tiffany Gerstmar at volunteernow@stc-sd.org.

Q: My name, employer, address, or e-mail has changed recently. How
do I change my member contact information?
A: Please contact MaryRose Velasquez or Rebecca Casto at the STC head
office in Arlington, Virginia, with your updates. You can find their contact
information by clicking: http://www.stc.org/contacts.asp.

Q: Where can I find copies of Intercom or Technical Communication
online?
A: You can find Intercom articles from 1996 to the present here:
http://stc.org/scripts/index/printIntercom2.asp.
You can find Technical Communication articles from 1995 to the present at
this one: http://www.techcomm-online.org/.

Q: What if I have more questions about the STC, the San Diego
Chapter, the monthly meetings, or the council?
A: Please contact any council member, or e-mail the treasurer at
treasurer@stc-sd.org.
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Welcome to Our New Members
By Sue Heim, VP Membership

 

 

 

Welcome to our new members--whether new to STC or to our San Diego
Chapter.

New Members

Michael Zsolszai
Michael Kreca
Michael McCabe

Members Who Have Transferred Into Our Chapter

James Cline
Julie Countryman
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Contact Gail

Quick Access to Microsoft® Word Templates
By Gail Van Landingham

Did you know that Microsoft Word includes a feature called "Workgroup templates?" This is a
rarely-used but powerful feature that allows everyone at a company to plug into a single source for
templates. By setting up Workgroup templates for your company, you can help make access to
documents easier and more efficient.

What are the benefits of Workgroup templates?
You can update the templates in one location on your network, and everyone will have instant
access. You just set up the file location one time for each employee.

Templates keep employees happy because they don't have to invent a document format over and
over again. They no longer have to create a title page, a table of contents, headers and footers, and
so forth.

Should I start small�or tackle the whole company?
Depending on how many templates have been created, and how far you want to reach, you can set
up Workgroup templates for just your technical publications group or for all employees at your
company.

What kind of templates are there? And who can use them?
At our company, we have general templates for the entire company as well as templates that are
specific to departments. Here are some sample folders and templates:

General Folder: Memo, Letterhead, Fax Cover●   

Forms Folder: Review Tracker, Change Order, Training Record●   

Service/Support Folder: Site Visit Report, Site Upgrade Report●   

Engineering Folder: Project Plan, Requirements Specification, Test Verification●   

How do you set up Workgroup templates?
Create a set of templates. (See your favorite Word book for details.)1.  

Copy the templates to a network location where your target users have access.

Tip: An ideal location is on a network drive that is automatically mapped for your target users.

2.  

Tell Word where the templates are located. You need to do this for every employee who needs
access.

3.  

Click Tools > Options > Click the File Locations tab. (See Figure 1)●   
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Figure 1: Selecting the file location for Workgroup templates

Double-click Workgroup templates.●   

Navigate to the location where you've saved the templates.●   

Click OK.●   

In the Options dialog box, confirm that the correct location is listed next to Workgroup
templates. Click OK again.

●   

Now put on your marketing hat, and tell the staff about the new, easy access to Word
templates. Tell them to:

4.  

Click File > New. (See Figure 2)●   
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Figure 2. Creating a new document based on one of the templates. The circled tabs correspond
to subfolders in the Workgroup templates location.
If you have Word 2000 or earlier: Select a template from the General tab, or from any specific
tab.

●   

If you have Word XP: In the New Document panel, click General Templates. Select a template
from the General tab, or from any specific tab.

●   

What about personal templates?
Word allows you to specify one directory for personal templates and one directory for Workgroup
templates. They are both on the File Locations tab when you select Options from the Tools menu.

Where do personal templates display?
Both personal templates and Workgroup templates display when you select New from the File menu.
If they are in the main directory selected, they will be under the General tab; if they are in
subdirectories, they will be under specific tabs.

How do the tabs correspond to file folders?
Each time you create a subfolder in the Workgroup templates location, Word creates a tab by the
same name. If the subfolder doesn't contain a Word document or Word template, there will be no
tab.

Is network connection required to set up Workgroup templates?
No. You can select any folder on your PC as the location for your Workgroup templates. This could
work for offsite staff with laptops. The drawback is that employees must update their own set of
templates. When you add or change a template, you may need a method to notify offsite employees.

Another helpful tip >>
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One Way to PDF
By Catherine Robinson

Author Bio

Contact Catherine

I had a difficult time trying to create a PDF of our online HTML version of the
Signature newsletter. As I experimented and ran into difficulties, Lana
Walker-Helmuth and Mark Hall came to my rescue and gave me the ideas I
needed to get this task done.

Rather than choose to print to "Acrobat PDFMaker" or "Acrobat Distiller," I
chose to open the Web page as PDF. I liked the navigation links that resulted
from choosing this method and felt that it was a better option for our
readers.

Let me take you through the steps I took to create PDF from HTML for the
Signature newsletter.

In Acrobat (not Acrobat Reader), go to File > Open Web Page as
PDF and open your home page.

I browsed the Web and found the exact location of the first page of the
newsletter. I then pasted that URL into the URL field in the Open Web
Page dialog box (Figure 1).

Figure 1. Selecting options to open Web pages in PDF

1.  

Select Level 2 in Levels and check the boxes, Only Get Pages Under
Same Path and Stay on Same Server (see Figure 1). (I did not
change any of the settings in Conversion Settings.)

When I selected Level 1 in Levels, only the first two pages of the

2.  
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newsletter were pulled into the PDF. I changed Level 1 to Level 2, and
then all the newsletter pages were pulled into the PDF.

Note: When I selected Level 2, a second set of newsletter pages was
created in the middle of the PDF. This was a result of the existing PDF
on the Web site being downloaded with the rest of the files. I was able
to delete these duplicate pages later in the process.

Click Download. After the pages have finished downloading, the file
opens up in Acrobat.

3.  

Delete the unnecessary set of pages by going into the PDF and
selecting the linked pages. Find the link with the plus sign (+),
highlight this link, and right-click. Select Delete to delete the
duplicated pages. This will dramatically reduce your PDF newsletter
size.

4.  

Save your file. You can rename the navigation links within your PDF
document as you see fit.

5.  

When you are done, save your file again.6.  

I want to mention one technical difficulty I ran into after the conversion: the
em-dashes in the articles did not convert properly. They appeared as little
square boxes in the PDF. I do not know if this is a problem with fonts missing
or my version of Acrobat 4.

I hope that one day this helpful tip comes in handy for you.
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Report of the Board of Directors Meeting
By Bonni Graham, Region 8 Director/Sponsor

 

Contact Bonni

The Board met September 11-13, 2003, in Portland, Oregon. We discussed a
variety of problems and improvements regarding Society governance. Some
of those issues are being explored in the Transformation Committee blog
(http://trans4mation.typepad.com). We welcome your input!

A great many changes in STC are necessary, and these are challenging times
for our Society. We are committed to preserving what works for us as a
Society and fostering the wonderful support and community we have created
over the past 50 years. We are exploring new financial models and better
ways of supporting chapters, SIGs, and members-at-large. Many of these
programs are still in the formative stages and thus necessarily abstract, but
the following concrete issues were addressed.

Chapter Achievement Awards (CAA)
Dale Erickson was appointed manager of the Chapter Achievement Awards
Judging Committee. As you may remember, the judging for the CAA has
changed. The Board decided to appoint a committee to examine submitted
materials and determine awards. Each submitting chapter will now have its
materials reviewed by three judges, who will determine the award. This
impartial judging method has been used successfully for other STC
competitions (such as Newsletter), and we think it will improve the CAA
competition.

Chapter Business
The following chapters were dissolved:

Mid-Hudson Chapter●   

North Central Florida Chapter●   

University of Wisconsin--Eau Claire Student chapter●   

STC Expands Our Network
Sandra Harner, STC's Assistant to the President for Academics, will represent
STC at the Council for Programs in Technical and Scientific Communication
(CPTSC) Conference in Potsdam, NY (at Clarkson University). This improves
our exposure to the teachers of the next generation of technical
communications professionals--and potential chapter members!

Annual Conferences
Pam Ecker has been appointed Program Manager for the 2006 conference, to
be held in Las Vegas, NV.

The Board has set the conference registration fee for the 2004 conference in
Baltimore, MD. Watch for the conference issue of Intercom for more
information.
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